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Disclaimer

Specifications written in this document are believed to be accurate, but are not guaranteed to
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specifically disclaims any implied warranty of merchantability or fitness for a particular purpose.
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About this document

Assumptions

This document assumes that you already have a solid knowledge of the following:

The software tools used for building your application (assembler, linker, C compiler).
The C programming language.

The target processor.

DOS command line.

If you feel that your knowledge of C is not sufficient, we recommend The C Programming Lan-
guage by Kernighan and Richie (ISBN 0-13-1103628), which describes the standard in C pro-
gramming and, in newer editions, also covers the ANSI C standard.

How to use this manual

This manual explains all the functions and macros that the product offers. It assumes you have
a working knowledge of the C language. Knowledge of assembly programming is not required.

Typographic conventions for syntax

This manual uses the following typographic conventions:

Style Used for
Body Body text.
Keywor d Text t.hat you entgr at the commgnd pnjompt or that appears on
the display (that is system functions, file- or pathnames).
Par anet er Parameters in API functions.
Sanpl e Sample code in program examples.

Sanpl e comrent

Comments in program examples.

Reference to chapters, sections, tables and figures or other doc-

Reference

uments.
GUIElement Buttons, dialog boxes, menu names, menu commands.
Emphasis Very important sections.
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Chapter 1

Introduction

The following chapter introduces J-Flash, highlights some of its features, and lists its re-
quirements on host and target systems.
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10 CHAPTER 1 What is J-Flash?

1.1 What is J-Flash?

J-Flash is a stand-alone flash programming software for PCs running Microsoft Windows.

J-Flash has an intuitive user interface and makes programming flash devices convenient. J-
Flash requires a J-Link / Flasher, JTAG emulator for ARM cores, to interface to the hardware.
Itis able to program internal and external flash at very high speeds, upwards of 550 KBytes/
s depending on the chip. Another notable feature is smart read back, which only transfers
non-blank portions of the flash, increasing the speed of read back greatly. These features
along with its ability to work with any ARM7 or ARM9 chip makes it a great solution for
most projects.

1.1.1 Supported Operating Systems

The following Microsoft Windows versions are supported:

Microsoft Windows 2000
Microsoft Windows XP
Microsoft Windows XP x64
Microsoft Windows 2003
Microsoft Windows 2003 x64
Microsoft Windows Vista
Microsoft Windows Vista x64
Microsoft Windows 7
Microsoft Windows 7 x64
Microsoft Windows 8
Microsoft Windows 8 x64
Microsoft Windows 10
Microsoft Windows 10 x64

=
=
N

Features

Any ARM7/ARM9/ARM11, Cortex-M0/M1/M3/M4/M7, Cortex-A5/A8/A9/R4/R5 and
Renesas RX600 core supported

e Microcontroller (internal flash) support.

Support for most external flash chips (For more information please refer to Target
systems on page 46).

High speed programming: up to 550 KBytes/s* (depending on flash device).

Smart read back: only non-blank portions of flash are transferred and saved.

Free evaluation licenses available.

Verbose logging of all communication.

.hex, .mot, .srec, and .bin support.

Intuitive user interface.

* = Measured with J-Link V10
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11 CHAPTER 1 Assumptions

1.2 Assumptions

This user manual assumes that you already possess working knowledge of the J-Link device.
If you feel that your knowledge of J-Link is not sufficient, we recommend the J-Link Manual
(UM08001), which describes the device and its use in detail.
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12 CHAPTER 1 Requirements

1.3 Requirements

J-Link / Flasher

Supported operating system (see Supported Operating Systems on page 10)
Interface from Host to probe (USB, Ethernet,...)

Supported device/core (see Supported microcontrollers on page 48)
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Chapter 2

Licensing

J-Flash may be installed on as many host machines as you want. Without a license key
J-Flash can still be used to open project files, read from connected devices, blank check
target memory, verify data files and so on. However to actually program devices via J-Flash
and J-Link, a valid license is required. For an overview which SEGGER products come with
a build-in license for J-Flash, please refer to the J-Link Model overview . All Flasher models
come with a build-in license for J-Flash.
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Chapter 3

Getting Started

This chapter presents an introduction to J-Flash. It provides an overview of the included
sample projects and describes J-Flash’s menu structure in detail.
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15 CHAPTER 3 Setup

3.1 Setup

The J-Link setup procedure required in order to work with the J-Flash is described in chapter
2 of the J-Link / J-Trace User Guide (UM08001). The J-Link / J-Trace User Guide (UM08001)
is part of the J-Link Software and Documentation Pack which is available for download under
https://www.segger.com/jlink-software.html.

3.1.1 Whatis included?

The following table shows the contents of all subdirectories of the J-Link Software and
Documentation Pack with regard to J-Flash:

Directory Contents

The J-Flash application. Please refer to the J-Link Manual (UM08001)
for more information about the other J-Link related tools.

\ Doc Contains the J-Flash documentation and the other J-Link related man-

uals.

\ETC\ JFl ash Two , .csv files for t.he J-Flash internal management of supported
MCU'’s und flash chips.

.\ Sam . . . . .

ol es\ JFI ash Contains sample projects with good default settings (see section

Sample Projects on page 16 for further details).

\ProjectFiles
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16 CHAPTER 3 Using J-Flash for the first time

3.2 Using J-Flash for the first time

3.2.1 Welcome dialog

When starting J-Flash, by default a startup dialog pops up which gives the user two options
how to proceed.

Welcome to J-Flash x

Flease zelect one of the follawing start options:

(+ Open recent project; | MK20DX128wx5 flash =l

(™ Create a new project.

[ D nat show thiz meszage again. Start J-Flagh

Welcome Dialog

The startup dialog provides the following options:

e Open open existing project: Select a project from the list of recent projects or select
“Other...” to open another existing project.
e Create new project: Creates a blank/empty project with J-Flash default settings.

If *Do not show this message again.” is checked, J-Flash will execute the option currently
selected automatically on future starts without showing the welcome dialog again.

3.2.2 Sample Projects

For some setups, special settings / configurations needs to be done in the J-Flash project
(e.g. PLL initialization, external bus interface initialization, script files, etc...). Therefore,
the J-Link Software and Documentation Pack already includes some example project for
various special setups which can be used as reference for custom setups.

Those project files can be found in the \Samples\JFlash\ProjectFiles subdirectory of the J-
Link Software and Documentation Pack installation directory.

3.2.3 Creating a new J-Flash project

The recommend way of getting started with J-Flash is to use the create new project wizard.

e Start by selecting the Create new project of the Welcome dialog or by selecting File
-> New project
e The new project wizard will launch, which looks like as follows:

Create New Project >

Target Device

|E0rteH-MD
Little endian =
Target Interface Speed [kHz)
|swD ~| | 4000 ~|

New project wizard
e Select the target device, the target interface and interface speed according to the setup.
If only a core is selected, the target endianness must be specified.
e Click OK

The created Project file is now ready for use. More sophisticated settings can be configured
in the Project settings. Please refer to Project Settings on page 27.
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CHAPTER 3 Using J-Flash for the first time

3.2.4 Creating a new init sequence

Many microcontrollers require a custom init sequence to initialize the target hardware, for
example the initialize the PLL, disable the watchdog or define the wait states of the flash.
This means that an compatible init sequence for the microcontroller must be built, if a new
project is created or one of the existing projects is modified.

A custom init sequence can be built or updated in the MCU tab of the Project settings
menu. Click the Add button to open the Add action dialog.

Add action b
Action T ype Delay
Delay - Q0000000 ] ms
Comment

|
k. | Cancel |

Init Steps: Add action dialog

In the Action Type choice-list all possible commands are listed. The following two text
boxes are dependent on the chosen command. They are grayed out or used to enter the
required parameter. The Comment text box should be used to enter a short description of
the action. For a list of all valid commands which can be used in an init sequence, please
refer to Init steps on page 30.
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18 CHAPTER 3 Using J-Flash for the first time

3.2.4.1 Example init sequence

A good example of a typical init sequence is the init sequence of an AT91SAM7 CPU. The
following example is excerpted from the J-Flash project for the AT91SAM7S256.

The example init sequence step by step

Reset the target with J-Link reset strategy 0 and 0 delay.

Disable the watchdog by writing to the Watchdog Timer Mode Register.

Set flash wait states by writing to the MC Flash Mode Register.

Set the PLL by writing to power management controller.

Set a delay of 200ms.

Set the PLL and the divider by writing to PLL Register of the power management
controller.

Set a delay of 200ms.

Set the master and processor clock by writing to the Master Clock Register of the power
management controller.

VRWNRO

N o

The steps implemented in J-Flash:

Project settings ? x
General | Target Intefface MCU | Flash | Production |

fig | L]

Device [v Check core 1D
|AtmeIATS‘I SAMTS25E J |D| 3FOFOFOF

Loz Clock speed Mask [FFFFFFFF

ARMTTOMI o Auto detection r
i
Litle endiarn 47923200 .&ddr|2DEIEIEIEI |E4 KB j

|Init steps j
# | Action | Waluel | Yaluel Comment
0 Reset a 0z
1 wirite 32hit 0=FFFFFC44  0«00008000  Disable watchdog
2 Write 32bit O<FFFFFFED 0400320300  Setflash wait states
3 Wwirite 32hit 0=FFFFFC20 000000801 Set PLL
4 Delay 200 mz
5 wiite 32bit 0=FFFFFC2C  0<00791C05  Set PLL and divider
& Delay 200 mz
7 Write 32bit OxFFFFFC30  0«00000007  Select master clock and...

add | | | |
oK | Cancel | |

MCU settings: Init Steps: Example
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3.2.5 Serial number programming

J-Flash supports programming of serial numbers. In order to use the serial number pro-
gramming feature, the J-Flash project to be used as well as some files in the working folder
(depending on the configuration) need to be configured first.

In general, J-Flash supports two ways of programming a serial number into the target:

1. Programming continuous serial numbers. Serial number is 1-4 bytes in size. Start serial
number, increment, serial number size and address have to be configured in the J-Flash
project production settings.

2. Programming custom serial numbers from a serial number list file. Start line into serial
number list file to get next serial number bytes, line increment, serial number sitze and
address is configured in J-Flash production project settings. Serial number list file needs
to be specified and created by user.

In the following, some generic information how to setup a serial number programming
configuration are given.

3.2.5.1 Serial number settings

In order to use the serial number feature, the J-Flash project has to be configured to enable
programming a serial number at a specific address. This is done by enabling the Program
serial number option as shown in the screenshot and table below:

Project settings 7 *

General | Target Interface | MCU | Flash  Production l

[v Enable target power [ Enable WTref moritar
Delay before start 20 ms 1000
5500

[v Program serial number

Address | 02007000 Len|d
Mext SM 1234567 Increment |1

Actions performed by "Production Programmming' [ Owenide timeouts
[v Erase Sectors if mot blank, 15000
[ Program 10000
v Werity via CRC - 10000

[ Start application  |%ia SFR access

0K | Cancel Apply |

Program serial number option

Setting Meaning

Address The address the serial number should be programmed at.

The length of the serial humber (in bytes) which should be programmed.

e If no serial number list file is given, J-Flash allows to use a 1-4 byte
serial number. In case of 8 is selected as length, the serial nhumber and
its complementary is programmed at the given address.

¢ In case a serial number list file is given, J-Flash will take the serial num-
ber bytes from the list file. If a serial nhumber in the list file does not
define all bytes of Len, the remaining bytes are filled with 0s. No com-
plements etc. are added to the serial number.

Len
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Setting Meaning

e In case no serial number list file is given, Next SN is next serial number
which should be programmed. The serial number is always stored in little
endian format in the flash memory.

e In case a serial number list file is given, Next SN describes the line of the
serial number list file where to read the next serial number bytes from.
J-Flash starts counting with line 0, so in order to start serial number
programming with the first line of the SNList.txt, Next SN needs to be
set to 0.

Increment | Specifies how much Next SN is incremented.

Next SN

3.2.5.2 Serial number file

When starting the program process Target -> Auto, J-Flash will create a serial humber
file named as <JFl ashPr oj ect Nanme>_Seri al . t xt . The file is generated based on the serial
number settings in the J-Flash project and will contain the value defined by the Next SN
option. The serial number file can also be manually edited by the user, since the serial
number is written ASCII.

3.2.5.3 Serial number list file

In order to program custom serial numbers which can not be covered by the standard
serial number scheme provided by J-Flash (e.g. when programming non-continuous serial
numbers or having gaps between the serial numbers), a so called serial number list file
needs to be created by the user.

When selecting Target -> Auto, J-Flash will check for a serial number list file named as
<JFl ashProj ect Name>_SNLi st .t xt in the directory where the J-Flash project is located.
The serial number list file needs to be created manually by the user and has the following
syntax:

e One serial number per line
e Each byte of the serial number is described by two hexadecimal digits.

Example

A 8-byte serial nhumber should be programmed at address 0x08000000. It should be pro-
grammed as follows in the memory:

0x08000000: 0x01 0x02 0x03 0x04 0x55 0Ox66 Ox77 0x88
The serial number list file should look as follows:
0102030455667788

7| Test_SMList.bet - Notepad - m} ®
File Edit Format View Help
0182030455667788

81e2030455667789
081082083845566778A

08102030455667788
0810203045566778C
08168203045566778D
81e820830845566778E
81820830845566778F
08102030455667790
81e2030455667791
081082030455667792
0102030455667793
08102030455667794
9192939455667795‘

SN list example

The number of bytes to read per line is configured via the Len option in J-Flash. For more
information, please refer to Serial number settings on page 19.
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Which line J-Flash will read at the next programming cycle, is configured via the Next SN
option in J-Flash. For more information, please refer to Serial number settings on page 19.
In this case Next SN needs to be set to 0, since programming should be started with the
serial number bytes defined in the first line of the file.

Note

If the number of bytes specified in a line of the serial number list file is less than
the serial number length defined in the project, the remaining bytes filled with 0s by
Flasher ARM.

Note

If the number of bytes specified in a line of the serial number list file is greater than
the serial number length defined in the J-Flash project, the remaining bytes will be
ignored by J-Flash

Note

When using Windows 7, please make sure that the used project file is located at a
folder with write permission.

3.2.5.4 Programming process

J-Flash will increment the serial number in <JFl ashPr oj ect Nane>_Seri al . t xt by the value
defined in | ncr enent , after each successful programming cycle.

3.2.5.5 Sample setup

In the following a small sample is given how to setup J-Flash for serial number program-
ming. In the following sample, 4-byte serial numbers starting at 1234567 (0x12D687) shall
be programmed at address 0x08001000.

Defining serial number address, length, start value and increment

In the J-Flash project the following needs to be defined:

Address is 0x08001000
Len is 4 (bytes)
Next SN is 1234567

[ )
[ )
[ )
e Incrementis1
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Project settings ? X

General ] Target Irlterface] MCU ] Fash  Production l

[+ Enable target power [~ Enable % Tref monitor
Lelay before start 20 ms 1000
5R00

¥ Program serial number

Address |08007000 Len|4
Mext SM (1234567 Increment |1

Actions performed by "Production Programming'' [ Owenide imeouts
[v Erase Sectors if not blank. « 15000
[v Program 10000
[v Werify wia CRC - 10000

[~ Start application  |'ia SFR access

ok | Cancel | Apply |

Program serial number option

Now J-Flash is prepared to program the 8-byte serial number. After programming the serial
number, J-Flash creates the <JFl ashProj ect Nane>_Seri al . t xt .

s

Mame Date modified Type Size

|| STM32ZE_Test_jflash 2017-04-07 1612 JFLASH File JKE
er STM3IZZE_Test_Serial bt 2017-04-07 1607 TXT File 1KB
[8] Test.mot 2017-04-07 16:10 MOT File 2 KB

Serial number file
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3.3 Menu structure

The main window of J-Flash contains seven dropdown menus (File, Edit, View, Target,
Options, Window, Help). Any option within these dropdown menus that is followed by a
three period ellipsis (...), is an option that requires more information before proceeding.

File menu elements

Command

Description

Open data file...

Opens a data file that may be used to flash the target device.
The data file must be one of the following: Intel HEX file, Motoro-
la S file, or Binary file (.hex, .mot, .srec, or .bin).

Merge data file...

Merges two data files (.hex, .mot, .srec, or .bin).

All gaps will be filled with FF. Find below a short example of
merging two data files named, File0.bin and Filel.bin into
File3.bin.

File0.bin —> Addr 0x0200 - 0x02FF
Filel.bin —> Addr 0x1000 - 0x13FF

Merge File0.bin & Filel.bin

0x0200 - 0x02FF Data of File0.bin

0x0300 - OxOFFF gap (will be filled with 0xFF if image is saved as
*.bin file)

0x1000 - Ox13FF Data of Filel.bin

Can be saved in new data file (File3.bin).

Save data file

Saves the data file that currently has focus.

Save data file as...

Saves the data file that currently has focus using the name and
location given.

New project

Creates a new project (See Creating a new J-Flash project)

Open project

Opens a J-Flash project file. Please note that only one project file
may be open at a time. Opening a project will close any other
project currently open.

Save project

Saves a J-Flash project file.

Save project as...

Saves a J-Flash project file using the name and location given.

Close project

Closes a J-Flash project file.

Save Flasher config
file...

Saves a .CFG file for stand-alone mode using the name and loca-
tion given. Please refer to the Flasher documentation (UM08022)
for more information regarding stand-alone mode.

Save Flasher data
file...

Saves a .DAT file for stand-alone mode using the name and loca-
tion given. Please refer to the Flasher documentation (UM08022)
for more information regarding stand-alone mode.

Download config &
data file to Flasher

Prepares a connected Flasher for stand-alone mode using the
current project and the data file which had focus most recently.
Please refer to the Flasher documentation (UM08022) for more
information regarding stand-alone mode.

Download serial
number file to Flash-
er

Downloads a serial number file to a connected Flasher. Please re-
fer to the Flasher documentation (UM08022) for more informa-
tion regarding stand-alone mode.

Recent Files

Contains a list of the most recently open data files.

Recent Projects

Contains a list of the most recently open project files.

Exit

Exits the J-Flash application.
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Command...

Description

Relocate...

Relocates the start of the data file to the supplied hex offset from
the current start location.

Delete range...

Deletes a range of values from the data file, starting and ending
at given addresses. The End address must be greater than the
Start address otherwise nothing will be done.

Eliminate blank ar-

€as...

Eliminates blank regions within the data file.

View menu elements

Command Description
Log Opens and/or sets the focus to the log window.
Project Opens and/or sets the focus to the project window.

Target menu elements

Command Description
Creates a connection through the Flasher using the configura-
Connect tion options set in the Project settings... of the Options dropdown
menu.
Di Disconnects a current connection that has been made through
isconnect

the Flasher.

Test > Generate test
data

Generates data which can be used to test if the flash can be pro-
grammed correctly. The size of the generated data file can be de-
fined.

Test > Test speed

Writes data of an specified size to an defined address, reads the
written data back and measures the up- and download speed.

Test > Show CFI in-
fo

Reads the CFI query information of a CFI compliant flash device.

Test > Hardware >
Activate BUSY

Sets the RS232 Busy signal of a connected Flasher. Can be used
to test the RS232 setup.

Test > Hardware >
Deactivate BUSY

Resets the RS232 Busy signal of a connected Flasher. Can be
used to test the RS232 setup.

Test > Hardware >
Activate OK

Sets the RS232 OK signal of a connected Flasher. Can be used to
test the RS232 setup.

Test > Hardware >
Deactivate OK

Resets the RS232 OK signal of a connected Flasher. Can be used
to test the RS232 setup.

Production Program-
ming

Performs a sequence of steps, which can be configured in the
Production tab of the Project settings. Additionally, the first step
executed are the init steps and the last step executed are the
exit steps, which both can be configured in the MCU tab of the
project settings.

Manual Program-
ming > Secure Chip

Secures the MCU.

Manual Program-
ming > Unsecure
Chip

Unsecures the MCU.

Manual Program-

ming > Check Blank

Checks flash to see if it is empty.
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Command

Description

Manual Program-
ming > Erase Sec-
tors

Erases all selected flash sectors.

Manual Program-
ming > Erase Chip

Erases the entire chip.

Manual Program-
ming > Program

Programs the chip using the currently active data file.

Manual Program-
ming > Program &
Verify

Programs the chip using the currently active data file and then
verifies that it was written successfully.

Manual Program-
ming > Verify

Verifies the data found on the chip with the data file.

Manual Program-
ming > Read back >
Selected Sectors

Reads back the data found in the selected sectors and creates a
new data file to store this information.

Manual Program-
ming > Read back >
Entire chip

Reads back the data found on the chip and creates a new data
file to store this information.

Manual Program-
ming > Read back >
Range

Reads back the data found in a range specified by the user and
creates a new data file to store this information.

Manual Program-
ming > Start Appli-
cation

Starts the application.

Options menu elements

Command

Description

Project settings...

Opens the project settings dialog.

Global settings...

Opens the global settings dialog.

Window menu elements

Command

Description

Cascade

Arranges all open windows, one above the other, with the active
window at the top

Tile Horizontal

Tiles the windows horizontally with the active window at the top.

Tile Vertical

Tiles the windows vertically with the active window at the left.

<List of currently
open windows>

A entry of the list can be selected to move the focus to the re-
spective window.

Help menu elements

Command

Description

J-Flash User Guide

Opens this document in the default .PDF application of the sys-
tem.

J-Link User Guide

Opens the J-Link Manual (UM08001) in the default .PDF applica-
tion of the system.

Licenses...

Shows a dialog with licensing information. The serial number of a
connected J-Link may be read and licenses added or removed.

About...

J-Flash and company information.
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Chapter 4

Settings

The following chapter provides an overview of the program settings. Both general and per
project settings are considered.
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4.1 Project Settings

Project settings are available from the Options menu in the main window or by using the
ALT-F7 keyboard shortcut.

4.1.1 General Settings

This dialog is used to choose the connection to Flasher. The Flasher can either be connected
directly over USB to the host system of J-Flash, or it can be connected through the J-Link
Remote Server running on a remote system. Refer to the J-Link Manual (UM08001) for
more information regarding the operation of Flasher and J-Link Remote Server. Select the
Engineering checkbox when setting up a project or the Simplified checkbox when using J-
Flash in production environments. In the simplified user interface some options are disabled
to decrease possible error sources in the production phase.

Project settings ? X

General ]Target Interface | MCU | Fash | Production |

J-Flazh iz a software for J-Link. |t requires a license,
which can be obtained from SEGGER

[wonan. z2qger. com).

Thiz zoftware iz capable of pragramming the flash

memory of seseral ARM micros, az well as extemnal
Flazh connected to ARM cares.

Connection to J-Link
v {I5E; Deviced =
" USBSH |0

C ICPAP |

User interface mode
{+ Engineering [More options, typically used for setup)

(" Simplified [Less options., typically used for production)

oK | Cancel

General Settings

USB

If this option is checked, J-Flash will connect to Flasher over the USB port. The default
device number is 0. For more information about how to use multiple Flasher on one PC,
please see also the chapter "Working with J-Link” of the J-Link Manual (UM08001).

USB S/N

If this option is checked, J-Flash will connect to Flasher over the USB port. J-Flash will only
use the Flasher with the specified S/N and any operation will fail if the Flasher with specified
S/N is not connected or cannot be used for any reason.

TCP/IP

If this option is checked, J-Flash will connect to Flasher via J-Link Remote Server. The
hostname of the remote system running the J-Link Remote Server must be specified.

4.1.2 Target Interface Settings

This dialog is used to configure the interface connection to the target.
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Project settings ? X

General Target Interface II\"ICU ] Fash ] Production

-
JTAG speed before init steps JTAG zpeed after init steps
" Auto selection " Auto zelection
" Adaptive clocking " Adaphive clocking
(14000 - | kHz (v 14000 | kHz

JTAG scan chain information

. Detect
* Auto detection
" Simple configuration i] 0

" Detailled configuration

B | Devicename D IRLen

Target Interface Settings

4.1.2.1 Interface Speed

The interface speed used before and after initialization can be configured. The interface
speed before init is used to communicate with the target before and during execution of
the custom initialization sequence (described in the section Init steps on page 30). The
interface speed after init is used to communicate after executing the custom initialization

sequence. This is useful if a target running at slow speed and the users wants to set up
a PLL in the initialization sequence.

For more information about the different types of interface speed please see the chapter
“Setup” of the J-Link Manual (UM08001).

4.1.2.2 JTAG scan chain with multiple devices

This checkbox allows to configure a JTAG scan chain with multiple devices on it. In a scan
chain configuration with multiple devices, the TCK and TMS lines of all JTAG devices are
connected, while the TDI and TDO lines form a ring.
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—|To1 - Device1 Toop p/toi Device 0 Too p—

pTMS
pTRST

—pTCK

Lp{TCK
L pTMS
L pTRST

L]

-
172}
o
[

TCK
TMS

I— ] 0O |¢——

JTAG

JTAG-chain

The position of the device to connect with J-Flash is selected from the Position dropdown
menu. The Instruction Register length (IRLen) of a device is defined by its manufacturer.
For ARM cores, the IRLen is always four, which is why the value of IRLen is by default set to
four times the position indicated. This works fine for ARM only scan chains. However, if any
non-ARM devices are introduced to the scan chain the IRLen must be modified accordingly.

4.1.3 MCU Settings

This dialog allows the selection of microcontroller dependent settings.

Project settings ? >

General | Target Inteface  MCU ]Flash ]Pmduc‘tion

[ Use d-Link script fie | =]
Device W Check core 1D
|ST STM3IZF103F o ID|3BA00477
Core Mask|OFODOFFF
Cortex-t3 P
Little: endian Addr| 20000000 95KE -
Init steps -
# | Action | Waluel | Waluel Cammett

0 Heset o O mz Reset and halt target

Add | | | _oown |

,T‘ Cancel | Apply |

MCU Settings

J-Flash can be used to program both external or internal flash memory. In order to use J-
Flash with an external flash device, the proper Core must be selected.
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To program internal flash devices choose the respective microcontroller in the Device list.
If a microcontroller is not found on this list, contact SEGGER, as new microcontrollers are
continuously being added.

Device

Select the respective microcontroller from the list to program internal flash devices. In
order to program external flash, select the device or core from the list.

Clock speed

For some devices, the actual CPU clock frequency in Hz of the MCU is required to guarantee
accurate operation of J-Flash. By default, J-Flash uses the “Auto” CPU speed detection
feature.

Endianness

The compatible endianness of the selected device is set automatically if possible. Otherwise,
select little endian or big endian from dropdown menu accordant to the device.

4.1.3.1 Check corelD

If the core ID is known for the device to be programmed, it can be used to verify that the
device in communication via the Flasher is the intended device. The core ID for all listed
devices is known, therefore this value is filled in automatically if a device is selected and
can not be modified. If only a core family is selected, the core ID field can be modified.

Mask

This option allows the user to mask out specified bits of the core ID. All bits set to 0 in
“Mask” are not taken into account when comparing the Code ID found by Flasher with the
Core ID entered in J-Flash.

Example:

Values Check result

Core ID entered: 0x3BA00477
Core ID found: 0x4BA00477 Failed
Mask: OxFFFFFFFF

Core ID entered: 0x3BA00477
Core ID found: 0x4BA00477 Passed
Mask: OxOFFFFFFF

The code ID check works as follows:

Cor el DFound &= Mask;

Cor el DEnt ered &= Mask;

if (Corel DFound != Corel DEntered) {
return Error; // Core ID check fail ed.

}

4.1.3.2 Use target RAM

The target RAM is used during flash programming to store the RAMCode. This RAM is called
work RAM. Defines the start address and the size size of the work RAM.

4.1.3.3 Init steps

Many microcontrollers require an initialization sequence for different reasons: When pow-
ered on, the PLL may not be initialized, which means the chip is very slow, or a watchdog
must be disabled manually. To use these chips the user must first perform the required
initialization.
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This dialog allows the user to enter a custom initialization sequence using a predefined list
of operations. After choosing an operation and corresponding values to be associated with
the operation, a comment may be added to make it easier for others to determine its effect.
The following list shows all valid commands which can be used in an init sequence:

Command

ValueO

Valuel

Description

Delay

Length of
the delay

Sets a delay.

DisableMMU

Disables the MMU.

Disable Checks

Disables JTAG checks. Some CPUs
(e.g. TMS470R1B1M) report JTAG
communication errors while initial-
izing, so that they can not be pro-
grammed if the JTAG communica-
tion checks are enabled.

Enable Checks

Enables JTAG checks. This option
is activated by default.

Go

Starts the CPU

Halt

Halts the CPU

Reset

J-Link reset
type

Length of
the delay

Resets the CPU. Refer to the J-Link
Manual (UM08001) for an detailed
explanation of the different reset
types.

Read 8bit

Address (Hex)

Reads 8bit from a given address
and stores the value in the internal
variable.

Read 16bit

Address (Hex)

Reads 16bit from a given address
and stores the value in the internal
variable.

Read 32bit

Address (Hex)

Reads 32bit from a given address
and stores the value in the internal
variable.

SetAllowRe-
moteRead

On/Off

This option defines if the emulator
(remote) or the host handles the
read access to the target. This op-
tion is activated by default to en-
hance the performance.

SetAllowRe-
moteWrite

On/Off

This option defines if the emulator
(remote) or the host handles the
write access to the target. This op-
tion is activated by default to en-
hance the performance.

Verify 8bit

Address (Hex)

Data (Hex)

Verifies whether 8bit data on a de-
clared address is identical to the
declared 8bit data.

Verify 16bit

Address (Hex)

Data (Hex)

Verifies whether 16bit data on a
declared address is identical to the
declared 16bit data.

Verify 32bit

Address (Hex)

Data (Hex)

Verifies whether 32bit data on a
declared address is identical to the
declared 32bit data.

Write 8bit

Address (Hex)

Data (Hex)

Writes 8bit data to a given ad-
dress.

Write 16bit

Address (Hex)

Data (Hex)

Writes 16bit data to a given ad-
dress.
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Command Value0O Valuel Description
Write 32bit Address (Hex) | Data (Hex) ZY,ZE‘:S 32bit data to a given ad-
WriteVerify 8bit | Address (Hex) | Data (Hex) | vries 8DIt data to a given address

. . . Writes 16bit data to a given ad-
Write&Verify 16bit Address (Hex) | Data (Hex) dress and verifies it afterwards.

. . . Writes 32bit data to a given ad-
Write&Verify 32bit Address (Hex) | Data (Hex) dress and verifies it afterwards.
Write Register Register Data (Hex) | Writes data into a register.

Write JTAG IR Command B Writes a command in the JTAG in-
struction register.

Write JTAG DR NumBits Data (Hex) ?’r\]’{(')tif]: J‘?ric(';agz‘ga”ﬁe”;ﬁgff bits

_ Logical AND combination of the in-
Var AND Value (Hex) ternal variable with a given value.
_ Logical OR combination of the in-

Var OR Value (Hex) ternal variable with a given value.

Var XOR _ Value (Hex) Logical XOR combination of the in-
ternal variable with a given value.
Checks if the internal variable is

Var BEQ Index - equal to 0. Performs jump to index
on match.
Checks if the internal variable is

Var BNE Index - not equal to 0. Performs jump to
index on match.

Var Write 8bit Address (Hex) | Data (Hex) ances 8bit dat_a of the internal
variable to a given address.

Var Write 16bit Address (Hex) | Data (Hex) | Writes 16bit data of the internal
variable to a given address.

Var Write 32bit Address (Hex) | Data (Hex) erfces 32bit da_lta of the internal
variable to a given address.

SetModeBigEndian | - _ fets bit 7 of the CP15 register to

SetModeLittleEndian | _ gets bit 7 of the CP15 register to
Writes 8bit data of the internal

Var Write File 8bit Address (Hex) | - variable to a given address in the
data file.
Writes 16bit data of the internal

Var Write File 16bit | Address (Hex) | - variable to a given address in the
data file.
Writes 32bit data of the internal

Var Write File 32bit | Address (Hex) | - variable to a given address in the
data file.

Comment : B Can be used as additional space to
insert comments. Does nothing.

Write File 8bit Address (Hex) | Data (Hex) | V1S d8abt'at gf‘eta to a given address

Write File 16bit Address (Hex) | Data (Hex) | Writes 16bit data to a given ad-

dress in the data file.
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Command Value0O Valuel Description
Write File 32bit Address (Hex) | Data (Hex) Z\{‘Zgisir?%ﬁ:at cclljtt: ;ci?ea given ad-

Note

All *"Write *” commands may only be used to write RAM or SFR registers, but not Flash
memory. Flash memory can only be influenced by altering the data file. The data file
can changed in the init steps by using the “Write File*” commands.

4.1.3.4 Exit steps

Those steps will be performed immediately after the target has been successfully pro-
grammed. In case of verify is checked in the production settings (Options -> Project
settings... -> Production settings tab), those steps will be performed after verify.

The Exit steps can be used to do some special handling after programming, for example to
set some security bits in order to secure the chip.

Note

Exit steps are only performed for “Target->Production Programming” operations.

4.1.4 Flash Settings

This dialog is used to select and configure the flash device to operate with. The listed
options of the Flash settings menu are dependent on the selection in the MCU Settings on
page 29. If a core family has been selected in order to program external flash memory
or a custom Flash Bank has been added and is selected, the menu should look similar to
the screenshot below.

Project settings 7 X
General | Target Interface | MCU  Flash | Froduction |

FlashBank Bark 0 = Chename ads | Do |

[ Use custom B&MCode | J

Base Addr 00000000 Organization[16 = |Bitsx [1 | Chipls]

[ Automaticaly detect flash memary

[~ Disable flash bank

’T‘ Cancel ‘ Apply |
Flash Settings: external Flash

If a specific device has been selected to program the flash of these device, the menu should
look similar to the screenshot below.
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Project settings ? X

General | Target Intedface | MCU  Flash I Production |

FlashBark [Eiank O Intemal flash] | [HeRafe

r [ =
Base Addr| 08000000

Info! ‘Inlema\ flash bank. 0 [Static sector lapout]

Manufacturer|ST
Device |STHM32F103VF
Size TEAKE  Sectors| 384

" Stait/End sector {+ Individual sectors
|Seclm[U] 08000000 J (v Sector(0]: 0x8000000 - 0xE0007FF ~

Sector{1 ], D+BO00800 - C5EO0DFFF
Seclof353] BEUBFFFE -] | < ) ougrnonn - oaBnon7FF

Selected ranges: Sector[3] 08001800 - 0x8001FFF
384 Sectors, 1 Range: Sector[4] 0x8002000 - 0x80027FF
0x6000000 - 0x80BFFFF Sector(5} 0x8002800 - 0x8002FFF

Sector[B]: 0x8003000 - 0x80037FF

W] Sertarl 71 MWRITAENN - MWRINFFE v

[ Disable flash bank ol | Nee | inven |

[ ok | cComcd | sy |
Flash Settings: internal Flash

41.4.1 Base Address
This is the base address of the flash.

4.1.4.2 Sector selection

The final section of this dialog indicates the sectors to be acted upon, whether they are to
be cleared, read back, or written. An individual or series of sectors may be selected from
the predetermined valid range.

4.1.4.3 Disable flash bank

The Disable flash bank checkbox disables the flash bank currently selected in the drop-
down menu, which can be used to change which flash banks are processed by J-Flash with
only one click per flash bank. This is especially useful when testing different configurations.

4.1.4.4 External Flash specific settings

Project settings ? X
General ] Target Interfface ] McU  Fash ] Production ]
FlashB ank | Bark 1 j Rename | Add | Delete |
[~ Use custom BAMCode | J
Ease Addr 00000000 Orgarization[16  w|Bitsx [1  «|Chip(s)
I~ Automatically detect flash memary Select flash device |
b anufacturer |AM o [v Check manufacturer fash 1d
Device[£m29DL161DB [¥ Check product flash |d
Size | 2048KB  Sectors| 39 Buswidth| 16 Id 12239
" Start/End zector * |ndividual sectars
|5 ecta0]: 0:0 | [ Secta0): 040 - Dx1FFF ~
- Sector[1]: 0x2000 - 0=3FFF
|Sectof38) OstFFFFF -] Sector2]: 0x4000 - 0xSFFF
Selected ranges: Sector[3]: 026000 - 0=7FFF
39 Sectors, 1 Flange: Sector[4]: 0=8000 - 0=9FFF
0x0 - Dx1FFFFF Sector8]: 0x4000 - DEFFF
Sector[B]: 0=CO00 - 0=DFFF
I S artard TF NuF OON - NWFFFF b
[ Disable flash bank sl | Mome | dmwer |

ok | Cancel | Aoply |

Flash Settings: external Flash, auto detection unchecked
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Organization

For some flashes (e.g. CFI compliant NOR flashes), the organization needs to be specified.
Configures the bus width and the number of flash chips connected to the address and data
bus of the MCU.

Select flash device

The flash device can be selected manually or the J-Flash Auto Detection feature can be
used. The auto detection feature is select by default. It supports both CFI compliant flash
memory chips and non CFI compliant chips. A flash device can be selected manually, if the
Auto Detection checkbox is deselected and the Select flash device button is clicked.

After invoking this button a table will be presented. The table may be filtered using the
manufacturer name. The chip and its attributes (manufacturer name, device name, size,
number of sectors, eight bit identifier, sixteen bit identifier, bus width) must be selected
from this table. If the flash chip is not found please contact SEGGER, as devices are con-
tinuously being added to this list.

Select flash device X

arutactrc [N -

Manufactuer | Deviee Size | MumSectors | Sbitld | TEbtld | Buswidth | 4
AMD Am29DL161DT 2048 KB 9 10036 12236 16
AMD Am23DL152DB 2043 KB 39 1002E 1222€ 16
AMD Am2IDL1BZDT 2045 KB 38 10020 12220 16
AMD Am25DL1B3DB 2045 KB 3 10028 12228 16
AMD Am29DL1E3DT 2045 KE kE) 10028 12228 16
AMD Am29DL1E4DB 2048 KE kE} 10035 12235 18
AMD Am29DL1E4DT 2048 KE kE} 10032 12232 18
AMD Am29DL322DB/GE 4095 KB 7 10056 12256 16
AMD Am29DL322DT/GT 4095 KB 7 10055 12255 16
AMD Am23DL323DB/GE 4095 KB 7 10053 12253 16
AMD Am2IDL323DTAGT 4035 KB 7 10050 12250 16
AMD Am25DL324DB/GE 4035 KB 7 1005F 1225F 16
AMD Am2IDL324DT /GT 4095 KB 7 1005C 12250 16
AMD Am29DL400BE 512KE 14 1000F 1220F 18
AMD Am29DL400BT 512KE 14 10000 12200 18
AMD Amz9DLB00BE 1024 KB 22 100CB 12208 16
AMD Am29DLB00BT 1024 KB 22 10044, 12248, 16
AMD Am29D5323DB 4095 KB 7 10088 12288 16
AMD Am29D53230T 4095 KB 7 10087 12287 16
AMD Am25F1008 128 KB 5 100DF 1220F 16
AMD Am25F100T 128 KB 5 10009 12209 16
AMD Am29F40088 512KE 1 10048 12248 18
AMD Am29F4008T 512KE 1 10022 12223 18
AMD Am2IFE008E 1024 KB 19 10058 12258 16
AMD Am2IFE008 T 1024 KB 19 10006 12206 16
A0 Am29l WVOMRR 128 KR in AN0RN AN0RN a i

Flash device Selection Dialog

ID checking

There are two other checkboxes that are of interest in this subsection which are “Check
manufacturer flash Id” and “Check product flash Id”. These checkboxes should be selected
to confirm the type of device that is in communication with J-Flash.
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4.1.5 Production settings

Project settings

General ] Target Interface] Mmcu ] Fash  Production I

[ Enable W Tref manitor

Delay before start 20 mz 1000

5500
™ Program sefial number
00a0oaoo0 g
o o
Actions perfformed by "Production Programming'' [ Ovemide timeouts
|v¥ Erase Sectors if not blank. 15000
[¥ Program 10000
v Merify via CRC - 10000

[~ Start application |'ia SFR access

oK | Cancel

Production Settings

Enable target power

Project Settings

Enables 5V target power supply via pin 19 of the emulator. Can be used for targets which
can be powered through the emulator for production. Delay before start defines the delay
(in ms) after enabling the target power supply and before starting to communicate with

the target.

Program serial number

J-Flash supports programming of serial numbers into the target in two ways. For a detailed
description how to use the serial number programming feature please refer to Serial number

programming on page 19

Actions performed by "Auto"

The checked options will be performed when auto programming a target (Target -> Pro-
duction Programming, shortcut: F7). The default behavior is

Init Steps (is always the first step)
Erase sectors if not blank

Program

Verify via CRC.

Exit Steps (is always the last step)

Steps not enabled per default:

e Start application
e Secure chip

Find below a table which describes the commands:

Command

Description

Init steps Executes the init steps defined in the MCU settings

Erase sectors

J-Flash User Guide (UM08003)

Performs an erase depending on the settings, selected in the

drop down box.

e Sectors: Erases all sectors which are effected by the image
to be programmed.
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Command Description
e Sectors if not blank: Erases all sectors which are both, ef-
fected by the image to be programmed and not already
blank
e Chip: Erase the entire chip independent of the content.
Program Programs the data file.

Verify

Verifies the program data.

e CRC: Verifies data via a high optimized CRC calculation
(recommended verification method).

e Complete data: Verifies data by reading it back.

Start application

Starts application after programming/verify completed.
Needs reset pin to be connected to Flasher.

Secure chip

Secures the device if supported by algorithm.

Exit steps

Executes the exit steps defined in the MCU settings

J-Flash User Guide (UM08003)
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4.2 Global Settings

Global settings ¥

Logging

General log level |{RE02 b

[ Enable J-Link logfilz
|E:'\Work\]LinkAF!M_SVN_Drg'\Dutpul\Hel- J

[ Enable J-Flazh logfile
|E:'\Work\]LinkAF!M_SVN_Drg'\Dutpul\Hel- J

Frojects

[~ Save Project file on close

Action on J-Flash start

" Load most recent project
" Show Mew Project Dialog
* Show welcome Dialog [default]

QK. | Cancel |

Global Settings

Global settings are available from the Options menu in the main window.

General log level

This specifies the log level of J-Flash. Increasing log levels result in more information logged
in the log window.

Enable J-Link logfile

If this option is checked, a file name of the J-Link logfile can be specified. The J-Link logfile
differs from the log window output of J-Flash. It does not log J-Flash operations performed.
Instead of that, it logs the J-Link DLL API functions called from within J-Flash.

Enable J-Flash logfile

If this option is checked, a file name of the J-Flash logfile can be specified. The J-Flash
logfile contains the same messages as the log window output of J-Flash.

Save project file on close

If this option is checked, J-Flash will always save the changes made to a project file when
a project or J-Flash is closed and therefore overrides the old project file without asking for
permission to do so.

Action on J-Flash start

In this section, the action J-Flash performs on startup can be selected.
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Command Line Interface

This chapter describes the J-Flash command line interface. The command line allows using
J-Flash in batch processing mode and other advanced uses.
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5.1 Overview

In addition to its traditional Windows graphical user interface (GUI), J-Flash supports a
command line mode as well. This makes it possible to use J-Flash for batch processing
purposes. All important options accessible from the menus are available in command line
mode as well. If command line options are provided, J-Flash will still start its GUI, but
processing will start immediately.

The screenshot below shows the command line help dialog, which is displayed if J-Flash is
started in a console window with JFlash.exe -help or JFlash.exe -?

Coemmandline >
'0' Valid command line options:
'_' -openpr) Opens an existing project
Syntax: -openprj<FILENAME:>
-saveprjas Saves current project in a different file
Syntax: -saveprjas<FILENAME>
-savepr) Saves current project
Syntax:  -saveprj
-open Opens a data file
Syntax: -open<FILENAME=[,<5ADDR>]
-5aveas Saves current data file in a different file
Syntax:
-saveas<FILEMAME= [, <SADDR=> <EADDR=]
-savecfg Saves emulater configuration file
Syntax: -savecfg<FILEMAME=
-savedat Saves emulator data file
Syntax: -savedat<FILENAME>
-save Saves current data file
Syntax: -save[<SADDR>,<EADDR>]
-download Downloads configuration to emulator
-merge Merges a given data file with the one currently

opened in J-Flash
Syntax:  -merge<FILEMAME= or
-merge<FILEMAME= bin,<ADDR=

-relocate Relocates data by given offset
Syntax:  -relocate<OFFSET>
-delrange Deletes data range
Syntax  -delrange<SADDR»,<EADDR>»
-eliminate Eliminates blank areas in data file
-connect Connects to target
-disconnect Disconnects from target
-securechip Secures target device
-unsecurechip Unsecures target device
-checkblank Blank checks target
-erasesectors Erases selected sectors
-erasechip Erases entire flash chip
-programverify Programs and verifies target
-program Programs target
-auto Erases, programs and verifies target
-production Erases, programs and verifies target
-verify Verifies target pregram
-readsectors Reads selected sectors
-readchip Reads the entire flash chip
-readrange Reads specified range of target memory
Syntax: -readrange<SADDR>,<EADDR>
-startapp Starts target application
-exit Terminates application automatically
-help Displays this box
-7 Displays this box
-jflashlog Sets a temporary J-Flash log file
Syntax:  -jflashlog<FILENAME=
-jlinklog Sets a temporary J-Link log file
Syntax:  -jlinkleg<FILENAME=
-ush COverrides connection settings to USE S/M
Syntax:  -usb<SN>
-ip Overrides connection settings to [P
Syntax:  -ip<roeioscccees or -ip<HostName=
-setriideode Sets the RXIDCode to be used by the
DLL.

Syntax: -setrxidcode<|DCodeString> (32
Characters, 16 IDCode bytes)
-min Starts J-Flash minimized

Command line options
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5.2 Command line options

This section lists and describes all available command line options. Some options accept
additional parameters which are enclosed in angle brackets, e.g. <FILENAME>. If these
parameters are optional they are enclosed in square brackets too, e.g. [<SADDR>]. Neither
the angel nor the square brackets must be typed on the command line, they are used here
only to denote (optional) parameters. Also, note that a parameter must follow immediately
after the option, e.g. JFl ash. exe -openprj C:\Proj ects\Defaul t.jfl ash.

The command line options are evaluated in the order as they are passed to J-Flash, so please

ensure that a project + data file have already been opened when evaluating a command

line option which requires this.

It is recommended to always use -open<FILENAME>[,<SADDR>] to make sure the right
data file is opened. All command line options return 0 if the processing was successfully.
An return value unequal 0 means that an error occurred.

Option Description
-? Displays the help dialog.
Executes the steps selected in Production Pro-
-auto gramming. Default: Erases, programs and veri-
fies target.
-checkblank Blank checks target.
-connect Connects to the target.

-delrange<SADDR>,<EADDR>

Deletes data in the given range.

-disconnect

Disconnects from the target.

-download Downloads configuration to emulator.
-eliminate Eliminates blank areas in data file.
-erasechip Erases the entire flash chip.
-erasesectors Erases selected sectors.

-exit Exits J-Flash.

-help Displays the help dialog.

-jflashlog Sets a temporary J-Flash lodfile.
-jlinklog Sets a temporary J-Link lodfile.

e -merge<FILENAME>
e -merge<FILENAME>.bin,<ADDR>

Saves the current data file into the specified
file. Please note that the parameters <SAD-
DR>, <EADDR> apply only if the data file is a
*.bin file or *.c file.

-min

Starts J-Flash minimized

-open<FILENAME>[,<SADDR>]

Opens a data file

Opens an existing project file. This will also au-

-openprj<FILENAME> tomatically open the data file that has been re-
cently used with this project.

-production Same as -auto

-program Programs the target.

-programverify

Programs and verify the target.

-readchip

Reads the entire flash chip.

-readsectors

Reads selected sectors.

-readrange<SADDR>,<EADDR>

Reads specified range of target memory.

-relocate<OFFSET >

Relocates data by the given offset.

J-Flash User Guide (UM08003)
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Option

Description

-save[<SADDR>,<EADDR>]

Saves the current data file. Please note that
the parameters <SADDR>,<EADDR> apply on-
ly if the data file is a *.bin file or *.c file.

-savecfg<FILENAME> Saves emulator config file.
-savedat<FILENAME> Saves emulator data file.

-saveprj Saves the current project.
-saveprjas<FILENAME> Saves the current project in the specified file.
-securechip Secures target device.

-setrxidcode<IDCodeString>

Sets the RXIDCode to be used by the DLL. Syn-
tax: -setrxidcode<IDCodeString> (32 charac-
ters, 16 IDCode bytes)

-startapp

Starts the target application.

-unsecurechip

Unsecures target device.

-verify

Verifies the target memory.

-usb<SN>

Overrides connection settings to USB S/N.

o —ipP XXX XXX XXX XXX >
e -ip<HostName>

Overrides connection settings to IP.

J-Flash User Guide (UM08003)

© 2004-2018 SEGGER Microcontroller GmbH



43 CHAPTER 5 Batch processing

5.3 Batch processing

J-Flash can be used for batch processing purposes. All important options are available in
command line mode as well. If command line options are provided, J-Flash will still start
its GUI, but processing will start immediately.

The example batchfile below will cause J-Flash to perform the following operations:

1. Open project C:\Projects\Default.jflash

2. Open bin file C:\Data\data.bin and set start address to 0x100000

3. Perform “Auto” operation in J-Flash (by default this performs erase, program, verify)
4. Close J-Flash

The return value will be checked and in case of an error an error message displayed. Adapt
the example according to the requirements of your project.

@CHO OFF

ECHO Open a project and data file, start auto processing and exit
JFl ash. exe -openprj C.\Projects\Default.jflash -openC:\Data

\ dat a. bi n, 0x100000 -auto -exit

| F ERRORLEVEL 1 goto ERROR

goto END

: ERROR

ECHO J-Fl ash ARM Error!

pause

: END
Starting J-Flash minimized
Adapt this example call to start J-Flash minimized:

start /mn /wait "J-Flash" "JFl ash. exe" -openprjC \Projects\Default.jflash \
-openC: \ Dat a\ dat a. bi n, 0x100000 -auto -exit

Note

that every call of JFl ash. exe has to be completed with the - exi t option, otherwise
the execution of the batch file stops and the following commands will not be processed.

J-Flash User Guide (UM08003) © 2004-2018 SEGGER Microcontroller GmbH



44 CHAPTER 5 Programming multiple targets in parallel

5.4 Programming multiple targets in parallel

In order to program multiple targets in parallel using J-Flash, the following is needed:

e J-Link / Flasher needs to be configured to allow to connect multiple ones to one PC at the
same time. Please refer to "UM08001 Working with J-Link and J-Trace” -> “"Connecting
multiple J-Links / J-Traces to your PC”

e One J-Flash project (containing the configuration).

Basically, J-Flash connects to a specific Flasher, configured in the project settings, but
there is a command line option available, which allows to temporary override this setting.
Therefore, only one J-Flash project is needed.

Find below a small sample which shows how to program multiple targets in parallel.

@CHO OFF
set | ocal
set "l ock=% enp% wai t % andon? | ock"

ECHO Launches 3 processes in parallel, where each process calls J-Flash with different serial nu
The stream of each process is redirected to a lock file so we can wait until each process has be
start "" 9>"9% ock%d" StartJFl ash. bat 164000000

start "" 9>"9% ock%®" StartJFl ash. bat 164000001

start "" 9>"9% ock¥3" StartJFl ash. bat 164000002

REM Wait until lock files are rel eased and del ete them afterwards

1>nul 2>nul ping /n 3 ::1

for 9N in (1 2 3) do (

(call ) 9>"% ock%®MN' || goto : Wit

) 2>nul

del "% ock%%"

pause

St art Fl ash. bat :

@CHO OFFECHO Open a project and data file and exit
start /wait "J-Flash" "JFl ash. exe" -usb%l -connect -exit
| F ERRORLEVEL 1 goto ERRCR

goto END

: ERROR

ECHO %ERRORLEVEL%

ECHO J-Fl ash: Error! SN %

pause

exit

: END

ECHO J- Fl ash: Succeed!

exit
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Device specifics

For some devices, special handling might be required. In order to find out if special handling
is necessary for the used device, please refer to the SEGGER wiki: SEGGER Wiki: Device
specifics
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Chapter 7

Target systems

The following chapter lists all supported flash devices.
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7.1 Which devices can be programmed by J-Flash?

J-Flash supports programming of internal and external flash devices. The external flash
device can be:

Parallel NOR flash
Serial NOR flash
NAND flash
DataFlash

For parallel NOR flash any combination of ARM CPU and parallel NOR flash device (1x8bit,
2x8bit, 4x8bit, 1x16bit, 2x16bit, 1x32bit) is supported, if the NOR flash device is CFI-
compliant. If the NOR flash device which is used is not CFI-compliant, the flash device has
to explicitly selected in J-Flash. For a list of all parallel NOR flash devices which can be
explicitly selected in J-Flash, please refer to Supported Flash Devices on page 48.

For serial NOR flash, NAND flash and DataFlash devices a custom RAMCode is needed since
the connection of the flash to the CPU differs from device to device.

For more information about which which microcontrollers with internal flash are supported
by J-Flash, please refer to Supported microcontrollers on page 48.

SEGGER is constantly adding support for new devices. If you need support for a chip or
flash not listed in the tables, do not hesitate to contact us.
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7.2 Supported microcontrollers

J-Flash supports download into the internal flash of a large number of microcontrollers. The
latest list of supported devices can always be found on our website:

List of supported devices

7.2.1 Supported Flash Devices

J-Flash supports a large number of external parallel NOR flash devices. In general, every
CFI-compliant parallel NOR flash device is supported by J-Flash. For non-CFI compliant
ones, J-Flash allows the user to explicitly select the device. The latest list of supported flash
devices can always be found on our website:

List of supported flash devices
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Chapter 8

Performance

For programming speed measurements, please refer to the SEGGER website: Internal
Flash programming performance
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Chapter 9

Background information

This chapter provides some background information about specific parts of the J-Flash
software.
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9.1 CRC of current data file

When opening a data file in J-Flash (File -> Open...), J-Flash calculates and displays the
CRC of the user data in this file.

ElL06 (=] 2 sl
Application log started

-J-Fash V6.15b {J-Flash compiled Apr 7 2017 15:38:42)

- JLink ARM.dIl V6.15b (DLL compiled Apr 7 2017 15:28:00)

Opening project file [C:\Word\MK2IWMK200X1 28005 flash] ...

Opening data file [C:\Wor \MK20WMKZ200X128_Blinky mat] ..
- Data file opened successfully (163840 bytes, 2 ranges, CRC of data = (xE7C39433)

CRC in Log Window

The following steps are taken into consideration when calculating this CRC:
1. The CRC is calculated over all sectors which are selected in the current project

Project settings ? x

General | Target Interface | MCU  Flash ] Production |

FlashBank [Eiank 0 (Intemal flash] | [Reramed]  add | |

r | []
Base Add [08000000

Info |Inlemal flash bank. O [Static sector layout]

Manufacturer |ST

Device [STM32F103vF
Size TEEKE  Sectors| 384

™ Start/End sector * |ndividual sectors
|Sector[D]: 02000000 J Sector[0]: 0x8000000 - 0x30007FF ~

- Sectar[1]: 0+8000300 - 0x8000FFF
Sector[383} DWBOBFFFF <] ¥ Sector[2]: 05007000 - 0x80017FF

Selected ranges: Sector[3]: 028001800 - 0<B001FFF
384 Sectors, 1 Range: Sector[4]: 028002000 - 0<80027FF
0+2000000 - 0«80EFFFF Sector[5]: 0x8002800 - 0x8002FFF

Sector6]: 0x8003000 - 0x80037FF
W Sertar 71 MLANNTANN - NWENNIFFF

[ Disabls flash bank al | Hone | et |

,Tl Cancel | Aoply |

CRC: selected sectors
2. Everything that is not covered by the data file (gaps in the data file, unused sectors
etc.) which is opened, is assumed as OxFF during the CRC calculation.
2. The polynomial which is used for the CRC calculation is 0xEDB88320.

W
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Support

The following chapter provides information about how to contact our support.
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10.1 Troubleshooting

10.1.1 General procedure

e Make sure the J-Link / Flasher is working as expected. See the troubleshooting article
in the SEGGER wiki: LINK

e Ensure that the target hardware matches the project file settings. Pay special attention
to the following aspects:

- Init sequence

- Clock speed

- RAM address

- Flash base address

- MCU / Flash chip

- Flash organization

e Theinterface clock frequency depends on several factors, e.g. cable length, target board
etc. Try setting the frequency to lower or higher values accordingly.

e Make sure the flash memory is unlocked before programming or erasing.

10.1.2 Typical problems

Failed to connect

Meaning:

This error message is shown if any error occurs during the connection process.

Remedy:

First of all, make sure the target is actually connected to J-Link. Verify the correctness of
the init sequence, check the JTAG speed, and ensure the correct flash type is selected.
Programming / Erasing failed

Meaning:

The flash memory sector may be locked and programming or erasing the respective memory
section fails therefore.

Remedy:

Make sure the memory sector is unlocked before programming or erasing. J-Flash provides
a dedicated menu item for unlocking flash memory.

Timeout errors during programming

Meaning:

A timeout occurs if the target is too slow during DCC communication or the target flash
memory is too slow during programming.

Remedy:
Using smaller RAM block sizes may fix this problem.

Blank check failed
Meaning:
The target memory was not empty during blank check.

Remedy:

Erase target memory.

RAM check failed

Meaning:
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No RAM found at the specified RAM location.

Remedy:

Make sure a correct RAM address is specified in the project settings. See section MCU
Settings.

Unexpected core ID

Meaning:

The specified CPU core ID does not match with the one read from the target CPU.
Remedy:

Ensure the specified core ID is correct for the used target CPU. See section MCU Settings
for information about setting the core ID.

Unsupported flash type / bus width

Meaning:

The target flash memory or the bus organization is not yet supported.

Remedy:

Inform us about the flash type you want to use. SEGGER is constantly adding support for
new flash memory devices.

No matching RAMCode

Meaning:

There is no programming algorithm available for the selected target memory type.
Remedy:

Inform us about the flash type you want to use. SEGGER is constantly adding support for
new flash memory devices.

J-Flash User Guide (UM08003) © 2004-2018 SEGGER Microcontroller GmbH



55 CHAPTER 10 Contacting support

10.2 Contacting support

If you experience a J-Flash related problem and the advices from the sections above do
not help you to solve it, you may contact our J-Flash support. In this case, please provide
us with the following information:

A detailed description of the problem.
The relevant logfile and project file. In order to generate an expressive logdfile, set the
log level to “All messages” (see section Global Settings for information about changing
the log level in J-Flash).

e The relevant data file as a .hex or .mot file (if possible)

e The processor and flash types used

Once we received this information we will try our best to solve the problem for you. Our
contact address is as follows:

SEGGER Microcontroller GmbH

In den Weiden 11
D-40721 Hilden

Germany

Tel. +49 2103-2878-0
Fax. +49 2103-2878-28
E-mail: support @egger.com

Internet: www. segger.com
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